
 

 

VIDEO (Part 2) 
 

 

A. TEORI dan PRAKTEK 

 

Memberi Efek Transisi 

 

Transisi video adalah efek yang menampilkan perubahan tampilan dari satu klip ke klip yang lain. 
Pada umumnya penerapan transisi video digunakan untuk proses penggantian tampilan antar 
klip. 
 
Dalam latihan memberi transisi digunakan setting project DV-PAL Standard 48 KHz, kemudian 
impor dua clip video dengan format file *.avi. File *.avi bisa didapat dari hasil capture camera 
video digital atau dari sumber lainnya. Dapat pula digunakan dua clip dengan format image 
(format file BMP dan JPG) untuk latihan. Yang terpenting apabila kita menggunakan setting 
project DV-PAL Standard maka ukuran frame (frame size) video dan image yang digunakan adalah 
720 x 576 pixel. 
 
1. Latihan Memberi Transisi 
 

Untuk lebih jelasnya maka akan dijelaskan langkah demi langkah proses pemberian transisi 
pada workspace Single Track Editing, caranya : 

 
1. Import clip kedalam Project Window. 

 
2. Kemudian susun salah satu clip yang ada di dalam Project Window ke dalam Track Video 

1 di dalam Timeline Window dengan melakukan drag and drop.  
 
 
 
 
 
 
 
 
 
 
 

 
Clip pertama yang disusun di dalam Timeline Window 



 

 

 

3. Geser Current Time Marker ke posisi waktu sebelum video berakhir untuk memberikan 

durasi transisi. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Current Time Marker digeser kedepan untuk memberi durasi transisi 

 
 

4. Setelah itu drag lagi salah satu clip yang ada di dalam Project Window ke dalam Timeline 
Window. Tempatkan clip tepat pada posisi Current Time Marker pada Track Video 1, 
overlap dengan clip pertama.  

 
 
 
 
 
 
 
 
 
 
 

 

Penempatan clip kedua pada Track Video 1 yang sengaja dibuat overlap dengan clip pertama 
 
 

5. Kemudian klik Tab Effects pada Project Window. Expandlah pilihan Video Transitions, 
selanjutnya expand pula pilihan Iris. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tab Effects di dalam Project Window 



 

 

6. Selanjutnya drag pilihan transisi Iris Diamond ke dalam Timeline Window, tempatkan di 
Track Video 1 tepat setelah Current Time Marker. 

 
 
 
 
 
 
 
 
 
 
 
 

Pemberian transisi pada Track Video 1 
 

 

7. Kita dapat melihat hasil pemberian transisi dengan melakukan Play pada Sequence 
Monitor Window atau dengan menekan Space Bar pada keyboard komputer (Adobe 
Premiere Pro tidak memerlukan proses render untuk memainkan hasil transisi).  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Hasil transisi dalam Sequence Monitor Window 
 
 

2. Mengatur Durasi Transisi 
 

Setelah diberikan transisi, mungin kita akan mengatur durasi transisi tersebut agar sesuai 
dengan yang kita inginkan. Untuk mengatur durasi berikut ini langkah-langkahnya : 

 

1. Pilih transisi yang akan diatur durasinya dengan cara klik satu kali pada transisi tersebut. 
Transisi yang aktif atau telah terpilih akan berwarna hitam seperti pada gambar di bawah 
ini.  

 
 
 
 
 
 
 
 
 
 
 

 
Pemilihan transisi yang akan diatur durasinya 



 

 

 

2. Buka Tab Effect Controls yang ada di dalam Monitor Window, jika belum ada pilih menu 
Window > Effect Control. Pada Tab Controls inilah kita melakukan pengaturan durasi 
transisi.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tampilan Tab Effect Controls dalam Monitor Window 
 

3. Kemudian ubahlah nilai pilihan Duration menjadi 00:00:02:10. Maka panjang durasi akan 
berubah. 

 
 
 
 
 
 
 
 
 
 

 
Tampilan Tab Effect Controls setelah panjang durasi transisi dirubah 

 
 

3. Mengatur Posisi Transisi 
 

 Sesuai dengan kaidah yang berlaku dalam workspace Single Track Editing, maka kita 
dapat merubah posisi transisi dengan metode Center of Cut, Start of Cut dan End of 
Cut. 

 Pengaturan posisi transisi dilakukan menggunakan pilihan Alignment yang berada 
pada Tab Effect Controls di dalam Monitor Window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Tampilan pop-up menu pilihan Alignment 



 

 

4. Menghapus Transisi  
Pada suatu saat mungkin kita perlu menghapus transisi yang telah kita buat, maka untuk 
menghapus transisi caranya pilih transisi yang akan dihapus kemudian tekan tombol Delete 
yang ada dalam keyboard komputer. 

 
 
5. Mengganti Transisi 

 
Sedangkan untuk mengganti transisi yang telah ada dengan transisi jenis lainnya, yang perlu 
kita lakukan adalah menimpa transisi yang lama dengan transisi yang baru pada posisi yang 
sama, maka transisi yang lama akan digantikan dengan transisi yang baru. Misalnya transisi 
lama kita adalah jenis Spin, kemudian kita akan menggantinya dengan jenis Cross Dissolve, 
maka yang perlu kita lakukan adalah mengambil transisi dari jendela Tab Effects di Project 
Window, kemudian kita drag and drop kedalam Timeline Window tepat pada transisi yang 
lama, maka secara otomatis transisi Spin akan berubah menjadi Cross Dissolve dengan durasi 
yang sama. 

 
 

 

Memberi Efek Pada Clip Video 

 

Sebagai alat editing profesional maka Adobe Premiere Pro juga dilengkapi dengan fasilitas Visual 
Effects. Kita dapat mengaplikasikan efek-efek visual yang menarik pada clip-clip yang telah kita 
susun di dalam Timeline Window. 
 

Kita akan mencoba untuk mengaplikasikan efek video pada clip yang ada dalam Timeline Window, 
sebelum masuk dalam latihan maka kita harus mempersiapkan project terlebih dahulu. 
 

Dalam latihan memberi transisi digunakan setting project DV-PAL Standard 48 KHz, kemudian 
impor tiga clip video dengan format file *.avi. File *.avi bisa didapat dari hasil capture camera 
video digital atau dari sumber lainnya. Dapat pula digunakan dua clip dengan format image 
(format file BMP dan JPG) untuk latihan. Yang terpenting apabila kita menggunakan setting 
project DV-PAL Standard maka ukuran frame (frame size) video dan image yang digunakan adalah 
720 x 576 pixel. Pada latihan ini ketiga clip video telah digabungkan dengan memberi transisi. Lalu 
akan diberikan efek video pada salah satu clip tersebut. 
 

1. Latihan Memberi Efek Video 
 

Setiap clip dapat diberi efek lebih dari satu jenis efek. Untuk memberikan efek visual pada 

clip video berikut ini langkah-langkahnya : 
 

1. Buka Tab Effects yang ada di dalam Project Window, kemudian expandlah pilihan Video 

Effects. Selanjutnya expand pula pilihan Blur and Sharpen. 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tampilan berbagai efek video di dalam Tab Effects 
 

2. Lalu pilih efek Ghosting, kemudian drag efek tersebut ke dalam Timeline Window, lalu 

tempatkan pada salah satu clip yang berada dalam Track Video. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Pilihan Efek videoGhosting di dalam Tab Effects 
 
 

6. Maka tampilan clip yang diberi efek Ghosting akan tampak seperti pada gambar di bawah 

ini. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Tampilan clip dengan efek ghosting 



 

 

2. Memodifikasi Keyframe Efek 
 

Pada penerapan efek yang dianimasikan pastilah memiliki keyframe, kita dapat memodifikasi 
keyframe, untuk memodifikasi durasi yang harus kita lakukan adalah menggeser keyframe 
pada posisi yang kita inginkan.  

 
 

 
Keyframe 

 
 
 
 
 
 

 

Memodifikasi durasi keyframe 
 

Sedangkan untuk menambah dan menghapus keyframe dibeberapa titik pada clip gunakan 

Add – Remove Keyframe pada track video. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Gambar hasil menambah keyframe di beberapa titik 
 
 

3. Menghapus Efek 
 

Untuk menghapus efek yang tidak terpakai caranya pilih efek yang akan dihapus di dalam 
pilihan Video Effects di dalam Tab Effect Controls, kemudian klik kanan pilih Clear. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Gambar proses menghapus efek 



 

 

4. Galeri Efek Video 
 

Adobe Premiere Pro memberikan banyak pilihan efek video yang terdapat pada tab Video 
Effects. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Galeri efek video di dalam Tab Effects 
 
 

 

TEKNIK EDITING TINGKAT LANJUT 

 

1. Memasang Universal Counting Leader 
 

Untuk menghitung mundur sebelum masuk ke video utama seringkali digunakan Universal 
Counting Leader. Untuk membuat Universal Counting Leader caranya : 

 
1. Pilih File > New > Universal Counting Leader.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Pilihan menu Universal Counting Leader 



 

 

2. Maka akan tampil window Universal Counting Leader. Kita dapat merubah ukuran 
Width dan Height, Timebase, Pixel Aspect Ratio dan Audio setting sesuai yang 
diinginkan. Kemudian tekan OK.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tampilan window New Universal Counting Leader 
 

3. Kita dapat mengganti warna jika diinginkan, kemudian aktifkan pilihan Cue Blip apabila 
kita membutuhkan suara beep pada saat hitungan mundur. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tampilan window Universal Counting Leader Setup 
 

 

4. Maka clip Universal Counting Leader akan tampil dalam Project Window, untuk 
memakainya tinggal lakukan drag and drop ke dalam Timeline Window. 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
Tampilan clip Universal Counting Leader 

 

2. Memasang Clip Bars and Tone 
 

Selain Universal Counting Leader kita juga dapat menambahkan clip Bars and Tone yang 
berfungsi untuk alat bantu kalibrasi. Biasanya ditambahkan 6 detik Bars and Tone di awal 
movie. Untuk membuat Bars and Tone caranya : 

 
1. Pilih File > New > Bars and Tone.  

 
 
 
 
 
 
 
 
 
 
 
 

 
Pilihan menu Bar and Tone 

 

 

2. Maka akan tampil window New Bar and Tone. Kita dapat merubah ukuran Width dan 
Height, Timebase, Pixel Aspect Ratio dan Audio setting sesuai yang diinginkan. 
Kemudian tekan OK. 
  

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tampilan window New Bar and Tone 



 

 

3. Maka clip Bars and Tone akan muncul pada Project Window, untuk memakainya 
lakukan drag and drop ke dalam Timeline Window. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Tampilan clip Bar and Tone 

 

 

3. Membuat Black Video  
Apabila kita ingin menyisipkan background hitam ke dalam video kita dapat menggunakan 
clip Black Video. Selain itu kita dapat menambahkan clip Black Video ke dalam Timeline pada 
awal movie dengan tujuan untuk menyediakan waktu bagi proses perekaman movie di video 
recorder. Untuk membuat Black Video caranya : 

 
1. Pilih File > New > Black Video.  

 
 
 
 
 
 
 
 
 
 
 
 
 

 

Pilihan menu Black Video 
 

2. Maka akan tampil window New Black Video. Kita dapat merubah ukuran Width dan 

Height, Timebase dan Pixel Aspect Ratio sesuai yang diinginkan. Kemudian tekan OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tampilan window New Black Video 



 

 

 

3. Maka clip Black Video akan tampil di dalam Project Window, untuk memakainya 

lakukan drag and drop ke dalam Timeline Window. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tampilan Black Video 
 
 

4. Membuat Transisi Dissolve Secara Manual  
Pada latihan ini kita akan mencoba membuat transisi dissolve sederhana menggunakan 
fasilitas Opacity. Berikut ini langkah-langkahnya : 

 
1. Buat clip Black Video dengan cara pilih File > New > Black Video. 

 
2. Maka clip Black Video akan tampil di dalam Project Window. Kemudian drag clip Black 

Video ke dalam Timeline Window. Letakkan pada Track Video 1. Durasinya 
diperpanjang sekitar 10 sampai 15 detik.  

 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tampilan clip Black Video yang disusun pada Track Video 1 di dalam Timeline Window 
 

3. Selanjutnya drag salah satu clip video yang ada di dalam Project Window ke dalam 
Timeline Window, lalu tempatkan pada Track Video 2, buat posisinya overlap dengan 
clip Black Video, seperti terlihat pada gambar di bawah ini. 



 

 

 
 
 
 
 
 
 
 
 
 
 
 

 
Penyusunan clip video kedua yang diletakkan pada Track Video 2 sengaja dibuat overlap 

dengan clip Black Video 

 

4. Lalu pilih clip kedua untuk mengaktifkan Tab Effect Controls dengan cara melakukan 

klik satu kali pada clip tersebut. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Pemilihan clip kedua 
 

5. Lalu expand pilihan Opacity yang ada pada pilihan Fixed Effects di dalam Tab Effect 

Controls. Secara default Opacity akan memiliki nilai 100. 
 
 
 
 
 
 
 
 
 
 
 

 

Pilihan Opacity yang ada di dalam Tab Effect Controls 
 

6. Kemudian kita akan memulai proses keyframing, pertama geser Current Time Marker 

ke posisi awal clip kedua. 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

Penggeseran Current Time Marker ke posisi awal clip kedua 
 

7. Kemudian klik tombol Add/Remove Keyframe  yang terdapat di sebelah kanan 
pilihan Opacity dalam Tab Effect Controls untuk membuat keyframe baru. 

 
8. Maka akan tercipta sebuah keyframe baru di sebelah kanan. Kemudian ubah nilai 

Opacity menjadi 0,0%. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Pembuatan keyframe dan perubahan nilai Opacity 
 
 

9. Maka tampilan dalam Sequence Monitor Window akan tampak tampilan clip Black 
Video, karena Opacity clip video pertama yang berada di Track Video 2 dirubah nilainya 
menjadi 0.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tampilan Sequence Monitor Window yang menampilkan clip Black Video 
 

10. Selanjutnya geser Current Time Marker ke posisi waktu akhir clip pertama, seperti pada 

gambar dibawah ini 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

 

Penggeseran Current Time Marker ke posisi akhir clip pertama 
 
 

11. Lalu ubah nilai Opacity yang ada di dalam Tab Effect Controls menjadi 100, maka secara 

otomatis akan tercipta sebuah keyframe. 
 
 
 
 
 
 
 
 
 

 

Perubahan nilai Opacity dan penambahan keyframe 
 
 

12. Maka jika movie dimainkan akan terlihat sebuah transisi dissolve sederhana dari 
tampilan hitam kemudian berangsur‐angsur menampilkan clip pertama. 

 
 
 
5. Menggunakan Adobe Photoshop CS Untuk Membuat Clip Yang Memiliki Alpha Channel  

Berbagai produk Adobe dapat diintegrasikan untuk memperoleh hasil kreativitas video yang 
maksimal. Kali ini kita akan mencoba mengintegrasikan Adobe Photoshop CS dengan Adobe 
Premiere Pro. Adobe Photoshop CS digunakan untuk membuat title, walaupun dalam Adobe 
Premiere Pro telah disediakan fasilitas Adobe Title Designer yang akan dijelaskan cara 
penggunaannya dalam bab berikutnya. Untuk membuat title menggunakan Adobe 
Photoshop CS caranya : 

 
1. Jalankan aplikasi Adobe Photoshop CS dari Start Menu > All Programs > Adobe 

Photoshop CS. 
 

2. Buat project baru dengan cara pilih File > New. 
 

3. Maka akan tampil kotak dialog New. Lalu isikan Name = alpha‐channel, Width = 720 
pixels, Height = 576 pixels, Resolution = 72 pixels/inch, Color Mode = RGB Color, dan 
Pixel Aspect Ratio = D1/DV PAL (1.09) kemudian tekan OK. 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Kotak dialog New 

 

4. Akan tampil area kerja Adobe Photoshop CS. 
 

5. Dengan menggunakan tools yang ada, buat image yang terdiri dari shape dan text. Lalu 

simpan dengan nama file alpha-chanel.psd. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tampilan file alpha-chanel.psd dalam Adobe Photoshop CS 
 

 

Untuk mengetahui cara penggunaan Adobe Photoshop CS lebih lanjut silakan baca buku yang 

khusus membahas cara penggunaan Adobe Photoshop CS. 



 

 

6. Metode Penggabungan Clip Yang Memiliki Alpha Channel  
Selain digunakan untuk membuat transisi sederhana, teknik Superimpose juga dipergunakan 
untuk menggabungkan clip yang memiliki Alpha Channel. Berikut ini langkah-langkahnya : 

 
1. Import file yang memiliki Alpha Channel, dalam latihan kali ini digunakan file bernama 

alpha-chanel.psd (dibuat menggunakan Adobe Photoshop dengan ukuran image 720 x 
576 pixel, dengan warna background transparan). Untuk melakukan Import pilih File > 
Import. 

 
2. Kemudian akan tampil kotak dialog Import, kemudian pilih file alpha-chanel.psd. Lalu 

tekan Open. 
 

3. Setelah itu akan tampil kotak dialog Import Layered File : alpha-chanel psd, kemudian 

pada pilihan Import As pilih Merge All Layer. Kemudian tekan OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Kotak dialog Import Layered File 
 
 

4. Maka file produser akan tampil di dalam Project Window. 
 

5. Kemudian kita akan menyusun clip ke dalam Timeline Window. Langkah pertama, drag 
salah satu clip yang ada di dalam Project Window ke dalam Timeline Window, 
kemudian tempatkan pada Track Video 1. Clip ini akan berfungsi sebagai background.  

 
 
 
 
 
 
 
 
 
 
 
 

 
Penyusunan clip pertama yang difungsikan sebagai background 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Tampilan clip pertama dalam Sequence Monitor Window 

 

6. Lalu drag clip alpha-chanel.psd ke dalam Timeline Window, letakkan pada Track 
Video 2, tepat diatas clip pertama. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Penyusunan clip produser.psd pada Track Video 2 dalam Timeline Window 
 

 

7. Maka tampilan movie dalam Sequence Monitor Window akan tampak seperti pada 
gambar di bawah ini. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tampilan produser.psd dalam Sequence Monitor Window 



 

 

7. Metode Penggabungan Clip Yang Tidak Memiliki Alpha Channel  
Pada latihan ini kita akan mencoba menggabungkan clip yang tidak memiliki Alpha Channel 
menggunakan fasilitas Opacity. Berikut ini langkah-langkahnya : 

 
1. Drag clip 1 yang ada dalam Project Window ke dalam Timeline Window, letakkan 

pada Track Video 1.  
 
 
 
 
 
 
 
 
 
 
 
 

 

Clip 1 diletakkan pada Track Video 1 dalam Timeline Window 

 

2. Kemudian drag clip 2 yang ada dalam Project Window ke dalam Timeline Window, 

letakkan pada Track Video 2. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Clip 2 yang diletakkan pada Track Video 2 

 

3. Lalu pilih clip 2 yang ada di dalam Timeline Window untuk menampilkan Tab Effect 
Controls. 

 
4. Kemudian expand pilihan Opacity yang ada dalam Tab Effects Controls. Selanjutnya 

ubah nilai Level menjadi 50%. 
 
 
 
 
 
 
 
 
 
 
 
 

 

Perubahan nilai Opacity pada clip 2 



 

 

5. Maka tampilan movie pada Sequence Monitor Window akan tampak seperti pada 
gambar di bawah ini. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Tampilan movie di dalam Sequence Monitor Window 
 
 
 
 

8. Unlink Video dan Audio 
 

Video hasil capture biasanya disertai audio/suara. Apabila disusun dalam Timeline Window 
maka clip tersebut akan menempatkan format video ke dalam Track Video dan format audio 
ke dalam Track Audio. Biasanya clip tersebut berwarna hijau. Jika clip dipindah atau digeser 
maka Track Video dan Track Audio akan ikut berpindah pada posisi yang sama.  
Berikut ini langkah-langkah untuk memisahkan (unlink) format video dan format audio dari 
clip video : 

 
1. Susun clip video hasil capture ke dalam Timeline Window.  

 
 
 
 
 
 
 
 
 
 
 
 
 
 

Susunan clip dalam Timeline 
 
 

2. Lalu pilih clip tersebut, kemudian pada menu pilih Clip > Unlink Audio and Video. 



 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Plhan menu Unlink 

 
 

3. Setelah itu coba pindahkan/geser clip yang berada di Track Audio ke sebelah kanan.  
 
 
 
 
 
 
 
 
 
 

Pemindahan posisi clip pada Track Audio tidak mempengaruhi clip yang ada dalam Track Video 
 

 

4. Maka clip yang berada di Track Video tidak akan ikut berpindah/bergeser. Anda bisa 

mengganti audio clip bawaan dengan audio yang diinginkan. 
 
 
 

 

C. TUGAS 

 

Edit file video hasil rekaman anda atau video lain hasil download menjadi sebuah video yang 

menarik untuk ditonton. Durasi video maksimal 5 menit, dan simpan dalam format .avi. 


